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What are QR codes? 

 
 
A QR code is a type of barcode that can hold more information than the familiar kind scanned at 

checkouts around the country. The “QR” stands for “quick response,” a reference to the speed at 

which the large amounts of information they contain can be decoded by scanners. They were 

invented in 1994 in Japan and initially used for tracking shipping.  As the code can be easily 

decoded by the camera of a BlackBerry, iPhone or other smartphone, this technology is 

increasingly accessible to the average person. Instead of tracking car parts and packages, the 

codes can work with the phone’s Internet browser to direct the visitor to online content quickly 

and efficiently. A QR code acts as a link embedded in the real world, integrating it with the 

virtual computer world. Currently they are being widely used for advertising campaigns, linking 

to company websites, contest sign-up pages and online menus. 

Museums 

Potential 

It is increasingly common to hear about museums developing smart phone applications.  Many 

large, well-known museums such as the Museum of Modern Art in New York and the Canadian 

Museum of Civilization are releasing standalone applications—or “apps”—which give iPhone 

users more information on museum exhibits and access to multimedia content like audio tours 

and short videos. These apps, however, can cost many thousands of dollars to develop, putting 

them out of reach to all but the largest institutions. Additionally, standalone apps can only be used 

by the types of phones for which they are designed. That means that only visitors with iPhones 

could use an iPhone app, even though other phones such as Androids and BlackBerries have 

similar abilities. 

 

QR codes have the potential to deliver similar content with very little to no overhead cost. They 

can be scanned by a range of devices, increasing the audience which can access them. By using 

this technology, even small, volunteer-run community museums can take advantage of new 

technology to provide a more interactive museum experience: granting virtual access to artifacts 

not on display, oral history interviews and deeper information that may not fit on labels or be 

interesting to all visitors.This information can be uploaded to the Internet on free sites like 

YouTube or Wordpress, and then linked through QR codes placed around the museum. For 

museums with online artifact databases, a link can be provided to the catalog record for each 

object on display. 

Precedent 

A number of museums have already been experimenting with the use of QR codes.   

See Appendix A for an overview of museums and cultural institutions that are currently using QR 

codes. 



How To 

Who can use QR codes? 

Three things are required in order to successfully decode a QR code: a smartphone, a QR code 

scanning application, and a connection to the Internet (either through the phone’s data plan or 

over a site-generated wireless network). 

The Phone 

In order to use QR codes, you need to have a cell phone capable of running decoding software. 

These phones can download and install applications, can access the Internet, and have cameras. 

These types of phones are loosely referred to as “smartphones”; the most common examples are 

iPhones, BlackBerries and Android phones.  

The Application 

There are a number of applications which can be used to decode a QR code, all of which work in 

similar ways. We have chosen to use ScanLife, a free app which has versions for a wide range of 

phones. Going to the website - http://getscanlife.com - on a phone’s Internet browser will 

automatically detect the type of phone and guide you to the appropriate version of the application. 

The Connection 

Because the QR code is a link to online content, you need to be able to connect to the Internet in 

the location where the codes are placed. Smartphones can connect to the Internet in two ways: 

through a 3G data connection, or through WiFi. 

3G Data Connections 

A data connection can be accessed anywhere there is good cellphone signal strength. It is a 

feature like talk time or text messaging, and most customers are given only so many MB or GBs 

of data a month—if they download too many things or visit too many websites, they can be 

charged a significant amount for overages. The benefit of relying on a data connection is that it is 

automatic: visitors do not have to set up or configure anything, and it is accessible almost 

anywhere you can make or receive a phone call. This simplifies thing by removing the burden of 

creating a good network from the shoulders of the museum. There can be some problems, 

however, with using the 3G data network which can result in visitors going over their monthly 

allotments and seeing charges on their monthly bill. It is also not as accessible to visitors from out 

of the country, as fees for data roaming—i.e. accessing a data connection outside of your home 

country—can be very expensive. Additionally, coverage in rural areas is still inconsistent 

between service providers. 

WiFi 

Most smartphones are able to connect to a regular wireless Internet network, AKA “WiFi.” This 

is the same kind of network which allows laptops and research stations in the museum to go 

online. When a cellphone is connected to the WiFi connection the user does not have to worry 

about data and roaming charges; they can watch as many videos and look at as many pictures as 

they please. However, it becomes the museum’s responsibility to ensure that coverage is good 

throughout the area which will have codes, and that individual visitors are able to connect to the 

network. This can be especially complicated if the wireless network is password protected.  

 

For this reason it is recommended that you have an open, password-free wireless network, as this 

provides the best experience for the most users. 



Security 

 

If the museum is going to share its wireless network with visitors it needs to ensure that any 

computers on that network are secure. To do this, make sure that that file and print sharing is 

turned off and that all user accounts on your computers have secure passwords. You should also 

secure your router by changing the default username and password; instructions on how to do this 

can be found in your router’s instruction manual.  

 

Some routers also have advanced features that you should use if they're available. One feature 

you should look for is the hours of operation security. This feature lets you designate certain 

hours that your wireless network will be active. For example you can set the wireless network up 

to start when the museum opens in the morning and automatically turn off at the end of the day. 

This is important because if you leave your wireless network open and unprotected, anyone with 

a laptop from outside or near the building would be able to make use of your Internet connection. 

If this option is not available, it is a good idea to turn off the router at the end of each day. 

 

If you are not sure how to set these features up, or you cannot find the information you need from 

documentation or searching the manufactures website, you should consult a computer technician 

in your area to help with this set up. Because unprotected wireless networks can easily be 

exploited for a variety of reasons it is very important to address this. 

 

Short URLs and Tracking Codes 

It is important to be able to track how many people are using the codes once you have installed 

them. We found that the easiest way to do this was by using a URL shortening service, like 

goo.gl. URL shorteners take long links and make them short. This is helpful for reducing the 

overall size of a QR code, as the more text it has to encode, the bigger it has to be. More 

importantly, however, by generating a new unique URL that is associated only with the QR code, 

it is easier to see who is checking out your content through the code itself as opposed to people 

who are finding your content by searching YouTube or clicking on browser links. Goo.gl 

automatically keeps track of who is viewing your link and how with charts and detailed 

information.  

 

 

 



To use this service, navigate to goo.gl and paste the link you would like to shorten into 

the text box, for example the address of a YouTube video you have uploaded. A short 

link will be generated when you click “shorten.” The service is free and does not require 

an account, however it is easier to keep track of the URLs you have generated if you are 

logged into a google account. Google accounts are free and can be created at 

http://google.com/accounts. 

 

After generating the short URL, click on “details” next to the URL’s list entry to view 

charts and more detailed statistics. This statistics page should be bookmarked or 

otherwise recorded, and checked regularly once the codes go live. 

 

Generating Codes 

QR codes can be created for free using any number of web-based forms. It is as simple as 

copying and pasting the desired link URL into a text box and hitting “enter.” You may have 

noticed that goo.gl even generates QR codes on the display page; this image can be saved to your 

computer and used. However, goog.gl only generates very small codes that are unsuitable for 

most printed materials.  For that reason our project used the QR code generator located on the 

Kaywa website, a site which provides services for the mobile web. It is located at 

http://qrcode.kaywa.com/.  

 

Making a Code with Kaywa 

 

1. Copy the short code for the content that you generated with goo.gl 

 



 

 

 
2. Open http://qrcode.kaywa.com/ and paste the address into the field labeled “URL” 

 

 

3. Choose what size you want to generate the code. Select your preferred size from the drop-down 

menu and click “generate.”The QR code will appear in the left-hand side of the screen. 

 



 

  
4. Right-click on the image of the QR code and save it to your computer. This image can now be 

printed, emailed, posted online or otherwise used. You’re done! 

 

 

 

Testing Codes 



The best way to test a code is with a smartphone with a working QR code scanner. If a 

smartphone is not available, software which allows a webcam connected to a computer to scan 

QR codes is available and listed in Appendix C: Web and Software Resources. 

Installing Codes 

Installing codes is as simple as printing them. They can be incorporated into other graphics such 

as exhibit labels or simply posted on their own. However, the codes must remain square and 

retain a white border around them. They may be as large as you wish; however, don’t make them 

smaller than about 4cm square as they may not be readable. 

Content 
QR codes are simply a way to deliver content to mobile devices. The focus is not QR codes but 

the content that they link to.  

 

Because the content is going to be viewed on a cellphone and in public, it is important to keep 

content short in length and small in file size. The Internet browsers installed on phones can also 

display things very differently from what you may see on a computer, and there is much 

difference from phone to phone as well. For this reason, we recommend using sites which have 

been pre-designed to display on mobile phones. Many popular, free sites—which you may 

already be using—automatically reformat your uploaded content when viewed from a phone. The 

list includes Flickr (images), YouTube (video), Wordpress and Tumblr (blogging and text) and 

Facebook and Twitter (social networking).  Using sites such as these eliminates hosting costs, 

provides some built-in statistical tracking and removes the need for advanced technical 

knowledge. If you are already using these sites it has the added benefit of re-purposing content 

which already exists. 

Suggested Content  

Detailed instructions for creating these projects can be found in Appendix B: Project How-Tos. 

1. Readings From Books 

Reading short sections of relevant published works can be an easy way to make engaging content. 

It’s easier to record high-quality audio than video, and if you’re selling the book in the gift shop it 

can make for a nice tie-in. These audio segments can be matched with photos, or even just your 

institution’s logo, and uploaded to YouTube.  

2. Oral Histories 

Oral History interviews with community elders make for engaging short content. They can be 

placed near items in the museum which they reference either thematically or directly—imagine, 

for example, a description of housework in the 1930s placed in the kitchen of a historic house 

museum. Since many institutions have oral histories as part of their collections, this is also a way 

to re-purpose already existing content and minimize workload. 

3. Photo Slideshows 

Another way to re-purpose existing content is to create simple slideshows using archival or other 

photos. These can be combined with either of the two audio types suggested above, paired to 

music or silent. 



4. Single Photos 

Even a single photo can make for effective content. One of our sites, for example, used QR codes 

to link to advertisements from the 1930s and 40s for objects they had on display. This method is 

simple, but effective. 

 

5. Database Records 

If some of your artifact records for objects on display have been placed online, a simple link to 

that content is a great way to share knowledge of that artifact that would otherwise be unknown. 

Records for items which are not or cannot be displayed due to interpretive choices or fragility can 

also be linked to, providing visitors with a peek into the “back room” of the museum. 

 

6. Audio Tours 
QR Codes can also be used to create narrated audio tours, providing introductions to rooms and 

further information on artifacts from curators and staff. 

About Our Project 

Background 
Over the past four years, community museums in Nova Scotia have participated in artifact 

research projects in order to enhance their knowledge of their collections.  Digital images of 

artifacts were taken, and the “enriched” records were uploaded to Artefacts Canada.  In addition 

to the research conducted on each specific item, a broader approach was taken in the compilation 

of a Nova Scotia Manufacturer’s Database.  Holding over 7300 entries related to artisans and 

manufacturing companies in the province, this information is not currently available to the 

general public, and is not being used by museums.  It is now time to incorporate this enriched 

information into the museums’ on-site interpretation. 

  

At the Association of Nova Scotia Museums’ (ANSM) 2010 Spring Conference members 

requested assistance with interpretation, especially in looking at ways to make things more 

interactive through the use of technology.  This was identified as one of their top three priorities 

for ANSM.  To deliver on this request, ANSM embarked on a project to build on the CHIN-

funded research work conducted over the past four years, and enhance the current interpretive 

offerings at participating museums.  

 

What we did 
ANSM worked with 12 museums from across the province to re-purpose existing content and 

develop new content to be posted online and shared on-site with QR codes: 

   

Admiral Digby Museum, Digby 

Citadel Hill Army Museum, Halifax 

Colchester Historical Museum, Truro 

Creamery Square Museum, Tatamagouche 

Memory Lane Heritage Village, Lake Charlotte 

North Highlands Community Museum, Cape North 

Nova Scotia Museum of Natural History, Halifax 



Nova Scotia Sport Hall of Fame, Halifax 

O’Dell House Museum, Annapolis Royal 

Pier 21: Canada’s Immigration Museum, Halifax 

Shelburne County Museum, Shelburne 

Trois Pignons Centre Culturel, Chéticamp 

 

These sites are spread out around the province, located in both rural and urban areas.  

They represent the diverse nature of Nova Scotia’s heritage, including a specialized 

military museum, a sports hall of fame, an Acadian cultural centre, and Canada’s newest 

national museum.  Operating structures range from various community museum models 

to the provincial and federal governments.  By working with such a diverse group of sites, it 

was hoped that all museums, regardless of site or resource constraints, would be able to see how 

such a project could be implemented in their own organization. 

 

Challenges 

Many of our biggest hurdles were caused by the structure of the project rather than any 

difficulties arising from QR codes and web content. Many of the sites we worked with 

were located many hours away from our office in Halifax, and the amount of time we 

were able to spend on-site was very limited. This meant that getting content from sites 

was often challenging. The distance also prevented more discussion about content types 

and possibilities. In a situation where content for QR codes were being developed in-

house, this would not be an issue. 

 

Here it should again be stressed that the key to the success of a project such as this is the 

content. The novelty of QR codes can only go so far, and if what they link to does not 

enhance a visitor’s museum experience they will not be viable over the long-term. 

 

Another issue we faced was the lack of standards for mobile content. There is a dizzying 

range of phones which can access QR technology, each with different display abilities; 

some, such as iPhones, display Internet content almost the same as a regular web 

browser, while others are very limited in their abilities. We received a large amount of 

conflicting advice and much time was lost trying to find the best way to deliver content, 

before ultimately deciding to rely on larger sites, like YouTube, which have already done 

the leg work of making content mobile-friendly.  

 

 



Appendix A:  QR Code Use in Museums and Cultural 

Institutions 
 
Powerhouse Museum, Sydney Australia 

Early adopter of QR codes. Experimented with in Using QR codes in 2008 to provide additional 

information about exhibits, links to audio, videos, etc, and documented the process on their blog. 

http://www.powerhousemuseum.com/  

http://www.powerhousemuseum.com/dmsblog/index.php/2009/03/05/qr-codes-in-the-museum-

problems-and-opportunities-with-extended-object-labels/ (link to blog) 

 

The Mattress Factory, Pittsburgh Pennsylvania 

Introduced QR codes in order to minimize the environmental impact of printing many visitor 

guides. Codes link to PDF documents, still images and YouTube-hosted video. 

http://www.mattress.org/ 

http://www.youtube.com/watch?v=WiYtISBl4PM (shows the codes in action) 

 

Cleveland Art Museum, Cleveland Ohio 

Used QR codes as part of an advertising campaign promoting the opening of several new 

galleries. The codes, which ran in print media and on outdoor kiosks and billboards,  linked users 

to an online version of the gallery audio tour. 

http://www.clevelandart.org/ 

http://www.capstonemedia.com/CapstoneBlog/?p=286 (blog post) 

 

MIT Museum, Cambridge Massachusetts 

Using QR codes to link to extended information on exhibits, such as articles. They have chosen 

not to provide any explanatory material about the codes, or to format the content for mobile web. 

http://web.mit.edu/museum/ 

http://think.random-stuff.org/posts/qr-codes-in-exhibits (blog post)  

 

Carinthia Open Air Museum, Carinthia Austria 

Uses QR codes in conjunction with a wiki site to provide more information about the buildings 

and sites around the museum in multiple languages.  

http://freilichtmuseum-mariasaal.at/ 

http://freilichtmuseum-mariasaal.at/wiki/ (wiki site) 

 

Louisiana State Museum, Baton Rouge Louisiana 

Used QR codes with the exhibit “Living with Hurricanes: Katrina and Beyond.” Codes were used 

to both enhance object presentation and to link to the exhibit’s Facebook page, allowing visitors 

to discuss their experiences of Katrina while exploring the exhibit. 

http://lsm.crt.state.la.us/ 

http://lsm.crt.state.la.us/katrina/index.htm (exhibit home page) 

http://blog.barcoding.com/2010/09/qr-codes-remembering-katrina/ (blog post discussing use of 

QR codes) 



Appendix B: Some Project How-Tos  
 

From Photos to Codes: Making a Photo Slide Show with Picasa From 

Start to Finish 

This is meant as a detailed guide that will walk you through all of the steps required to go from a 

handful of photos to a fully functioning QR code ready for installation, and once installed, 

capable of being monitored for user traffic. This process can be repeated with any kind of content 

that you like. 

 

This guide will walk you through all the steps needed to create a photo slideshow, upload it to 

YouTube and create a QR code to link to it. You will need Picasa (see Appendix C) and a 

YouTube account. 

Step 1: Select Your Photos 

 

 

 

The first step in making a slideshow is to choose the photos you would like to use. To begin, 

launch Picasa and browse to the folder where the photos you want are located (1). Clicking on the 

folder name in the left-hand navigation will show all of the pictures in it in the main window (2). 

Clicking on a photo will highlight it in blue and add it to the selection window (3). Multiple 

photos can be selected by holding down the “ctrl” button while clicking, or clicking and dragging. 

 



 

 

When you are happy with your selection as it appears in the selection window, navigate to the top 

menu bar and select Create > Movie > From Selection... 

Step 2: Add Text Slides, Captions, and Audio 

 

 

 

This will launch the Movie Maker window. The main components are the left navigation, which 

has three tabs (Movie, Slide and Clips)(1), the preview window (2) and the selection timeline, 

which allows you to see what photos are included in the slideshow and preview it (3). By default, 



a black and white text slide showing the name of the originating folder and the approximate date 

the photos were created is added to the beginning of the slideshow. 

 

* 

 

The movie tab on the left-hand navigation controls general settings for your slideshow. The 

“Load” and “Clear” buttons allow you to add or remove audio or narration. Transition style 

controls how each photo transitions to the next. 

 



 

 

The slide tab controls settings for whatever slide is currently highlighted in the timeline. The text 

field controls captions and text for text slides; the template above it selects how the text is to be 

displayed.  Captions can also be added to photo slides. 

 

The two buttons underneath the green triangle play button in the timeline allow you to add text 

slides (the white button) or remove the highlighted slide (the red “x”). 

 



* 

 

The clips tab allows you to add more photos to your slideshow. By default, the other photos in the 

originating folder which you did not select for your timeline will be displayed here. To add one, 

select it and press the green plus button. To add a clip that is not found here, press the “get more” 

button. 

 



 

 

Pressing the “get more” button will return you to the general library view, where you can 

navigate and select photos just as you did at the beginning of your project. When you have 

selected the photos that you want, press the “back to movie maker” button. 

 

Your slideshow can be previewed by pressed the green arrow button.  

Step 3: Create Movie & Upload to YouTube 

 

When you are happy with your movie, press the YouTube button located in the left-hand 

navigation. The system will prompt you for your log-in information, and ask for a title and 

category for your movie. Remember to click the check box that makes the movie public. You will 

be notified once your movie has finished uploading. 



Step 4: Generate a Short URL and a QR Code 

 

 

 

Once your movie has finished uploading, go to YouTube and log in to your account. A list of all 

your uploaded movies can be found by clicking on your username and selecting “my videos.” 

Find the video you have just uploaded in the list and open it. 

 

 

 

 

Watch the movie through to make sure you are happy with it. If you are, highlight and copy the 

URL of the video, found in the address bar. Generate a short URL using this information and 

goo.gl (see How To > Short URLs and Tracking Codes above), and a QR code by using the 

Kaywa site (see How To > Making a Code with Kaywa: Step-by-step, above). Print off the code, 

place in the museum, and you’re done! 

 

 



Tips for Shooting Video 

 

Know your equipment 

Some of the first video we shot was done using my iPhone. While the quality is great, at the time 

I didn’t realize that I was shooting the wrong way. As a result, all of the video we got from that 

day is sideways, and turning it is a major technical hassle. The lesson to take away from this? 

Before you’re planning on recording anything, take a few test shots with your camera and upload 

them to your computer. Spend time familiarizing yourself with how everything works: how to 

record, stop, playback, and how long your camera will let you record for. Then, when you’re 

shooting for real, you won’t risk making small errors that will cost you lots of time later on. 

 

Be Consistent 

It’s a lot easier to learn how to deal with just one set of equipment, file formats and software than 

to have to deal in multiples. Find one camera and stick with it. 

 

Test Before You Delete 

This might seem obvious, but keeping it in mind can save you major headaches down the road. 

Never delete anything off of your camera without making sure it’s properly uploaded to your 

computer. Video files are big and prone to file corruption when you’re moving them from your 

card to your desktop. Use the software that came with the camera, or if you’re directly moving 

things from the SD card or other media, be sure to copy and paste rather than drag and drop. 

Then, watch the file all the way through to make sure that both the audio and video have 

transferred properly. If not, play back the file in your camera to make sure it’s not a problem with 

the video itself, and then try again. 

 

Back Up Your Files 

It’s much easier to burn a CD or DVD than it is to try and recover something that’s been deleted, 

and you never know when you’ll want to revisit something that you shot previously. This is 

especially true for things like oral history interviews, which become a part of your collection. 

 

Bring Extra Everything 

Make sure you have extra batteries and memory cards, and that your batteries are fully charged 

and your cards are empty BEFORE you start to shoot. Nothing is worse than a camera going dead 

right in the middle of something exciting. 

 

Shoot with a Story in Mind 

Have an idea of what you want the finished video to look like before you start shooting. Make a 

list of the shots you need and how they will fit together. This will save you headaches when 

you’re editing and also help make sure you don’t miss anything or need to do re-shoots. 

Editing Video in Windows Movie Maker 

Windows Movie Maker (WMM) is not the best or most efficient video editing software out there. 

However, it comes pre-installed on all computers with Windows XP and Vista, meaning that it is 



already available to most museums. It can be found under Programs > Entertainment in the 

Windows Start menu. 

Understanding the Timeline View 

(Screenshots are from WMM for Windows XP) 

 

 

 
1. Collections Drop Down Menu 

Allows you to navigate between different “collections”—ie, video files—that you have imported 

into WMM. 

 

2. Clips Window 
Shows all the clips available in a collection. This window is where you cut down larger files into 

smaller chunks. Any supplemental photos and audio you import will also appear here. 

 

3. Preview Window 
Previews photos, video clips, audio files and your edited movie. 

 

4. Playback Controls 
Play, stop, rewind, fast forward, and frame-by-frame advance. 

 

5. Split Clip 
Splits the previewed clip into two at the selected point. 

 

6. Zoom Buttons 

Zooms in and out of the timeline.  

 

7. Show Storyboard / Show Timeline Button 



Toggles between storyboard and timeline view. Storyboard is simpler, but timeline provides more 

control. 

 

8. Timeline 

Clips from the clip window are dragged here to begin constructing a movie. 

Loading Files to Edit 

The first step of editing video in WMM is to load the raw files that you have shot with your 

camera. To do this, press ctrl+I or select File > Import into Collections... from the top menu. 

 

WMM cannot edit every type of video file. For instance, it cannot load .mov files, which are a 

common format in which many cameras shoot. If you are having problems loading files into 

WMM, you must use a video conversion program to translate you files into something that WMM 

can read, such as an .AVI or .WMV. Some free suggestions for file conversion software can be 

found in Appendix C: Web and Software Resources. 

 

Turning Files into Clips 

In most cases, the video you have shot will need to be edited to take out parts that you do not 

want or need or to reorder and combine different scenes. To do this, the files you have imported 

need to be cut down into a series of clips. 

 

To make a clip, double-click on the file you have imported. It will begin playing in the preview 

window. When it has reached a point where you would like to split the video file—for example, 

right before a new question is asked in an oral history interview—pause the video by pressing the 

stop button or the spacebar and click on the “split clip” button. Continue doing this until your 

video is transformed into a more manageable series of chunks. A good tip is to give each clip a 

name which reflects its contents—you can rename a clip by right clicking on it. This is especially 

helpful when editing down a very long or complex file. 

 

Additional still images or audio files can be brought into the clips window by using the same 

“Import into Collections...” dialogue you used to import your video file. These files will also 

show up as clips. 

 

Turning Clips into a Movie 

To begin building a movie, drag the desired clips from the clip window into the timeline. 

Transitions between clips and special effects can be added by right-clicking a clip and choosing 

“Video Effects.” Captions and text slides can be added by selecting Tools > Titles and Credits 

from the top menu bar. 

 

Sound on clips can be muted or have its volume adjusted by right-clicking on the sound track. If 

you would like to use only the sound from a particular clip—for instance, to use as narration over 

a still image—click on the clip in the timeline and drag it down into the Audio/Music bar. This 

will remove the video component.  

 



 
 

The timeline view in WMM. Note that the leftmost clip is a combination of a still photo and sound taken 

from another clip by dragging it into the Audio/Music bar. 

 
To preview your movie, click on the beginning of the time line and press play in the preview 

window or press the space bar. 

 

Saving Your Movie 

Clicking the “save” button only saves your timeline. This is helpful for when you wish to come 

back and finish editing a project later; however, in order to save a full movie file that can be 

uploaded to to the web, you must select File > Save Movie File from the top menu bar. Choose to 

save the file to your computer. The file will be saved in .wmv format. 

 

Audio Editing Tips & Tricks 

 
1. Like with video, it pays to know your equipment. While microphones come in all shapes, sizes 

and price ranges the quality of a mid-range USB mic or stand-alone recorder should do the job for 

most voice recordings. Make test recordings. Many things can negatively effect sound quality, 

including room acoustics, ambient noise, voice levels, and even humidity. Try recording in 

different parts of the room and play with the distance between the microphone and the subject 

until you are happy with the sound quality. Listen to test runs with headphones to better hear what 

they sound like. 

 

Be aware of wind when outside and try to aim for calm weather, or conduct the recording in a 

shelter. Some noise attributed to wind is almost inescapable in outdoor settings, but mic covers 

and “blimps” can be used to help deaden the sound. 

 

2. Make sure to save your audio in an appropriate file type. .Wav files are high quality and 

represent the full spectrum of sound. However, they are very large, and not suitable for online 

use. Mp3 files are the usual Internet standard. Some quality will be lost, but the file size will be 

much smaller, and more programs are able to play back the files. 

 

3. When outputting your audio it is important to note the decibel level of your master volume. A 

decibel (dB, db) is a unit used to express the intensity of a sound wave. dB is a measure of 

amplification not volume, so 0dB means that the signal is in its original, unaltered state. Get as 



loud a level as you can when recording. If you are seeing red then back the volume off or move 

the mic further from the sound source. 

 

Editing Audio with GarageBand 

This guide will cover basic techniques for recording and editing sound in GarageBand, an audio 

editing program that comes pre-loaded on Mac computers. However, most of the basic principles 

apply to any audio editing program that you have access to. If you require a free program which 

is compatible with both Window and Apple machines, please see Appendix C: Web and Software 

Resources. 

 

 

 
1. Individual Track  

This panel shows the track name, effect applied, panning parameter and a volume slider. You 

don’t want the signal to go from green to red. This means you are “peaking” and the signal 

strength will cause distortion in your sound. Try to aim as close to this without crossing into the 

red for the fullest sound. 

 

2. Waveform 
This is a visual representation of the recording along a timeline, or a waveform. It is shown below 

in the editing screen. This allows you to zoom into areas for fine tuning of your audio file.  

 

3. Recording Button 

Clicking this will begin recording, using whatever device you have installed on your computer.  

 

4. Basic Control Buttons  
From left to right: Back to the start, rewind, fast-forward, play, and loop. 

 

5. Clock 
Shows where in the track your cursor is located. 

 



6. Master volume 
This effects all tracks you may have in a session. The green bars show the amplification of the 

sound as it plays. Your individual tracks will all contribute to this, so if you are seeing red try and 

tone down the loudest tracks in your session. 

 

7. Effects panel 
Because this track was a voice recording and my subject was male, I chose the setting Male 

Speech. Most programs will have a few simple effects that will improve sound without having to 

do a lot of manual tweaking. 

 



Appendix C: Web and Software Resources 

QR Code Readers 

Phone readers: 

 

ScanLife: http://getscanlife.com 

● Scans QR, DataMatrix, ScanLife and traditional barcodes. 

● Works on most phones; does not work with iPhones that are not updated to OS 4.0 

  

BeeTagg: http://get.beetagg.com 

● Scans QR and BeeTagg codes 

● No longer works for BlackBerry 

  

Many more QR code readers (of varying quality) can be found by googling, or by searching the 

iPhone app store, BlackBerry AppWorld and the Android Market.  

 

Additionally, most BlackBerries now come with a code reader pre-installed, which can be found 

under BlackBerry Messenger > Scan a Group Bar Code. 

Desktop Readers: 

QuickMark for Desktop/Webcam: 

http://www.quickmark.com.tw/En/basic/download.asp#QuickMark_WebCam 

● Need to register, but free 

● Uses your webcam, allowing you to check QR codes without a smartphone 

  

ZXing Decoder: http://zxing.org/w/decode.jspx 

● Allows you to decode QR codes from the image itself 

● Handy if you have neither a webcam or a smartphone 

Other Helpful Web Resources 

Opera Mini Simulator - http://www.opera.com/mobile/demo/ 

● Allows you to preview what your content will look like on phones running the Opera 

mini browser 

 

Windows Movie Maker help home page: 

http://www.microsoft.com/windowsxp/using/moviemaker/default.mspx 

● Troubleshooting, how-tos and more. 

 

Pew Research Center 2010 report on Smartphone usage in the US:  

http://pewresearch.org/pubs/1654/wireless-internet-users-cell-phone-mobile-data-applications 



● Shows that “Six-in-ten American adults are now wireless internet users, and mobile data 

applications have grown more popular over the last year.” 

 
Avery - http://www.avery.com/avery/en_us/ 

● Online label generating software 

Software 

Here are a variety of useful (and free!) programs that we used during our project: 

 

Picasa: http://picasa.google.com 

● For basic image manipulation, cataloguing and especially creating video slideshows. 

 

Free Video Converter 1.0: http://www.tucows.com/preview/518513 

● For converting files from one file type to another, to ensure compatibility with editing 

software and smaller sizes. 

 

Free M4A to MP3 Converter: http://download.cnet.com/Free-M4a-to-MP3-Converter/3000-

2140_4-187723.html 

● Converts M4A audio files into more easily editable and common MP3 and WAV 

formats.  

 

Audacity: http://audacity.sourceforge.net/ 

● Sound editing 

 

LAME MP3 Encoder: http://lame.buanzo.com.ar/ 

● Allows Audacity to save files as MP3s. 

● Instructions on how to download and install can be found on the Audacity website: 

http://audacity.sourceforge.net/help/faq?s=install&i=lame-mp3 

 

GIMP: http://www.gimp.org/ 

● Advanced image editing 



Appendix D: Glossary 

3G 

Short for “third generation,” it is a mobile phone standard which allows for faster communication 

and access to the mobile web through a data connection. 

App 

Short for “application,” apps are computer programs downloaded to a cellphone which can 

perform a wide range of device-specific functions. Apps can be anything from standalone games 

to alarm clocks to city guides and more. QR code scanners are apps. 

Data 

When a smartphone is not connected to a wireless Internet connection, it can still access the 

Internet by drawing off of a data plan which is incorporated into a monthly service plans. These 

plans have caps, and often steep overage fees, but allow the user to access the Internet from 

almost anywhere. 

 

Decibel (dB, db) 
A unit used to express the intensity of a sound wave. It is a measure of amplification and not 

volume. 

Mobile Web 

The mobile web is the Internet as accessed by a cellphone. 

QR Code 

Short for “Quick Response Code.” QR Codes are barcodes which can be scanned with a cell 

phone camera and used to direct visitors to Internet content. 

Smartphone 

A cellular telephone that provides far greater computing power than conventional cell phones. 

They offer full Internet access, the ability to install third party applications and often have touch 

sensitive screens. Popular smartphones include the iPhone, BlackBerries and Android phones. 

WiFi 

WiFi enabled devices, such as laptops and smartphones, are able to wirelessly access the Internet 

when in the range of a wireless router’s signal. 

 


